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ESTABLISH A NEW ACH PAYMENT 
You can generate a new ACH payment using the + New payment functionality. 

To establish a new ACH payment 
1. Sign in to Business Online. The system displays Business Online. 

2. From the Payments & Transfers.  The system displays the Payments & Transfers page. 

3. Select ACH. The system displays the ACH transfer page. 

4. Select + New payment. This system displays the New payment dialog box. 

5. Select the appropriate Type (for example, Payroll – PPD) from the drop-down list. Click 
Continue. The system displays the New payment page. 

6. Type the Description of the transfer (for example, Monthly Payroll).  

7. Select the tax identification number that the system associates with the transfer from the Tax 
identification number drop-down list. 

Note: In some instances, the system associates an ACH user (for example, George Washington) with multiple 
companies (for example, Washington Farms and Washington Orchards). In these cases, the system populates the 
Tax identification number drop-down list with each of the companies that it associates with the user. 

8. In the Effective date field, type the date you intend the new ACH transfer to process. 

9. Select the Repeat check box to establish the frequency with which the new ACH transfer 
occurs, if more than once.  

10. If you have selected Repeat, select the Frequency from the drop-down list to establish 
how often the transfer occurs. 

Note:  When you select a recurring frequency value, the system populates the transfer with an additional 
date field titled End date. Type the end date of a recurring transfer as the End date.  

11. Type the Company description. 

12. In the Pay from section, select the appropriate Account from the drop-down list and type the 
Amount that the system debits from the account.  

13. In the Pay to section, complete the following for each recipient: 

a. Type the Name of the recipient. 

b. Type the Identification number of the recipient. 

c. Type the Routing transit number of the recipient. 

d. Type the Account number of the recipient.  

e. Select the appropriate Account type. 

f. Type the Amount to deposit in the recipient’s account.  

14. Click Complete ACH, the system displays the processing results page.  

15. Repeat steps 3 through 16 to generate additional transfers. 

16. Sign out of Business Online. 
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ESTABLISH A NEW ACH COLLECTION 
You can generate a new ACH collection using the +  New ACH collection functionality. 

To establish a new ACH collection 
1. Sign in to Business Online. The system displays Business Online. 

2. Select Payments & Transfers.  The system displays the Payments & Transfers page. 

3. Select ACH. The system displays ACH transfer page. 

4. Select + New collection. The system displays the New collection dialog box. 

5. Select the appropriate Type (for example, Prearranged payment – PPD) from the drop-down 
list. Click Continue. The system displays the New collection page. 

6. Type the Description of the transfer (for example, Monthly service contract).  

7. Select the tax identification number that the system associates with the transfer from the Tax 
identification number drop-down list. 

Note: In some instances, the system associates an ACH user (for example, George Washington) with multiple 
companies (for example, Washington Farms and Washington Orchards). In these cases, the system populates the 
Tax identification number drop-down list with each of the companies that it associates with the user. 

8. In the Effective date field, type the date you intend the new ACH transfer to process. 

9. Select the Repeat check box to establish the frequency with which the new ACH transfer 
occurs, if more than once.  

10. If you have selected Repeat, select the Frequency from the drop-down list to establish 
how often the transfer occurs. 

Note: When you select a recurring frequency value, the system populates the transfer with an additional date 
field titled End date. Type the end date of a recurring transfer. 

11. Type the Company description. 

12. In the Pay from section, complete the following for each recipient: 

a. Type the Name of the recipient. 

b. Type the Identification number of the recipient. 

c. Type the Routing transit number of the recipient. 

d. Type the Account number of the recipient.  

e. Select the appropriate Account type. 

f. Type the Amount to deposit in the recipient’s account.  

13. In the Pay to section, select the appropriate Account from the drop-down list and type the 
Amount that the system debits from the account.  

14. Click Complete ACH, the system displays the processing results page.  

15. Repeat steps 3 through 16 to generate additional transfers. 

16. Sign out of Business Online. 
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INQUIRE INTO AN ACH PAYMENT OR COLLECTION  
You can find information about ACH transfers using Inquire ACH Transfer functionality. 

To inquire into an ACH payment or collection 
1. Sign in to Business Online. The system displays Business Online. 

2. Select  Payments & Transfers. The system displays the Payments & Transfers page. 

3. Select ACH. The system displays the ACH transfer page. 

4. Type search criteria as needed then click Submit. The system displays a list of transfers on the 
ACH Activity page. 

5. Locate the ACH transfer that you want to inquire into and click the down arrow next to the 
transfer to view a brief overview of the transfer. 

6. Locate the ACH transfer that you want to inquire into and click on the Description 
hyperlink that the system associates with that particular transfer. The system displays the 
ACH transfer details page. 

7. Review the ACH transfer. Complete steps 7 through 10 as needed. 

8. To generate a report, click Report. The system displays the Transfer report dialog box. 

9. Select PDF (.pdf) or Comma separated value (.csv) from the Format drop-down list and click 
Download report.  

10. Click Return to ACH activity. The system displays the ACH Activity list page. 

11. Repeat steps 2 through 10 to inquire into additional ACH transfers. 

12. Sign out of Business Online. 
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MODIFY AN ACH PAYMENT OR COLLECTION 
You can modify ACH transfers Change ACH Transfer functionality.  

To modify an ACH payment or collection 
1. Sign in to Business Online. The system displays Business Online. 

2. Select Payments & Transfers.  The system displays the Payments & Transfers page. 

3. Select ACH. The system displays the ACH transfer page. 

4. Click Edit for the appropriate transfer from the list. The system displays the edit page for 
transfer. 

5. Modify as needed: 

a. In the Description field, modify the name of the transfer (for example, Wash 
Orchards Payroll becomes Wash Orch Pay). 

b. Select the tax identification number that the system associates with the transfer from 
the Tax identification number drop-down list. 

c. Type the date that you intend the ACH transfer to process in the Effective date field. 

d. The frequency with which the ACH transfer occurs in the Frequency field. 

Note: When you select a recurring frequency value, the system populates the transfer with an additional date 
field titled End date. Type the end date of a recurring transfer. 

 

e. The description according to your needs in the Company description field. 

f. The information in the fields populating the Pay from  section and the Pay to 
section. 

6. Click Complete ACH. The system displays the confirmation page. 

7. Sign out of Business Online. 
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REVIEW ACH TRANSFERS 
Review ACH Transfer functionality ensures that individual ACH users or institutions can review and 
approve ACH transfers before the system processes them. 

To review an ACH transfer 
1. Sign in to Business Online. The system displays Business Online. 

2. Select the appropriate check boxes for the transfers listed in the ACH section of the Payments 
& Transfers widget on the home page. 

3. Select Review ACH Transfer and then click Submit. The system displays the Review ACH 
Transfers list. 

4. Locate the ACH transfers that require review from the ACH section of the Payments 
Transfers widget on the home page and select Approve or Disapprove. The system displays 
the Security Challenge dialog box. 

Note: You can approve or disapprove all of the ACH transfers populating the ACH Transfers list by selecting the 
Description check box. 

5. Type the appropriate token response and click Complete Challenge.  

6. Sign out of Business Online. 
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DELETE ACH TRANSFERS 
Delete ACH Transfer functionality ensures that an ACH user can delete saved ACH transfers or ACH 
transfers that have not completed processing. 

To delete an ACH transfer 
1. Sign in to Business Online. The system displays Business Online. 

2. Select Payments & Transfers.  The system displays the Payments & Transfers page. 

3. Select ACH. The system displays the ACH transfer page. 

4. Use the Search activity fields to narrow the list of ACH transfers that the system returns. 

5. Click Delete for the appropriate transfer. The system displays the Delete transfer page. 

6. Recurring ACH Transfers Only: Select the appropriate value from the Deletion type drop-
down list.  

7. Click Delete ACH. The system displays the processing results page. 

8. Repeat steps 2 through 7 to delete additional ACH transfers. 

9. Sign out of Business Online. 

 
ESTABLISH A NEW ACH TRANSFER USING AN EXISTING ACH TRANSFER 
You can generate new ACH transfers using an existing ACH transfer when you use the New Change ACH 
Transfer functionality. 

To establish a new ACH transfer using an existing ACH transfer 
1. Sign in to Business Online. The system displays Business Online. 

2. Select Payments & Transfers.  The system displays the Payments & Transfers page. 

3. Select ACH. The system displays the ACH transfer page. 

4. Locate the appropriate transfer that you want to use and click Copy. The system displays 
the [Transfer name] page. 

5. In the Description field, type the name of the new transfer (for example, Wash Orchards 
Payroll). 

6. Modify as needed: 

a. Select the tax identification number that the system associates with the transfer in the 
Tax identification number drop-down list.  

Note: In some instances, the system associates an ACH user (for example, George Washington) with multiple 
companies (for example, Washington Farms and Washington Orchards). In these cases, the system populates the 
Tax identification number drop-down with each of the companies that it associates with the user. 

b. Type the date that you intend the new ACH transfer to process in the Effective date 
field. 

c. Optional: Select the Repeat check box to define the Frequency that the transfer 
occurs, and the End date. 
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7. Type the appropriate information in the fields populating the Pay From section and the Pay 
To section. 

8. Click Complete ACH. The system displays the processing results page. 

9. Click Return to ACH activity to return to the ACH Activity list or click Save as template to 
initiate the process of establishing a new template based on the transfer that you just 
established. 

10. Repeat steps 2 through 12 to generate additional transfers. 

11. Sign out of Business Online.  
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GENERATING PDF FORMATTED REPORTS – TRANSFERS 
Print functionality provides users with the ability to print ACH transfer and ACH transfer template data 
in a PDF format when inquiring into individual transfers and transfer templates. 

Generate PDF formatted reports for ACH transfers 
1. Sign in to Business Online. The system displays Business Online. 

2. Select Payments & Transfers. The system displays the Payments & Transfers page. 

3. Select ACH. The system displays the ACH transfer page. 

4. Optional: Use the search criteria to narrow the list of transfers and click Search. The system 
refreshes the page with the new search results.  

5. Click Report to generate a report for all items that the system displays. The system displays 
the Activity report dialog box. 

6. Select the appropriate Type check boxes (for example, File information, Batch information, 
and/or Transactions) for the information that you want the system to include in the report.  

Note:  If you select more than one Type check box, the system compiles the report in a Zip file, ACHReports.zip.  
This will include the selected Types (Transfer list, Batch list, and All Transactions) and the files will be named 
according to the name convention below. 

 

7. Select PDF from the Format drop-down list. 

8. Click Download report. When the system prompts you, select the local folder to which you 
want to save the formatted report.  

Note: By default, the system generates a PDF formatted report that uses the naming convention TransferDetail_ 
MMDDYYYYHHMMSS.pdf. 

• MM = the month that the system generates the PDF report. 

• DD = the day that the system generates the PDF report. 

• YYYY = the year that the system generates the PDF report. 

• HH = the time of day in hours that the system generates the PDF report. 

• MM = the time of day in minutes that  the system generates the PDF report. 

• SS = the time of day in seconds that the system generates the PDF report. 

9. Once you save the PDF formatted report, open the report in Adobe Reader. The system 
displays the PDF formatted report for the ACH transfer. 

10. When you complete your review of the report, close Adobe Reader. 

11. Repeat steps 3 through 10 for each set of ACH transfers that you want to generate a PDF  
formatted report for. 

12. Sign out of Business Online.  
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GENERATING PDF FORMATTED REPORTS – TEMPLATES 
Print functionality provides users with the ability to print ACH transfer and ACH transfer template data 
in a PDF format when inquiring into individual transfers and transfer templates. 

Generate PDF formatted reports for ACH templates 
1. Sign in to Business Online. The system displays Business Online. 

2. Select Payments & Transfers. The system displays the Payments & Transfers page. 

3. Select ACH. The system displays the ACH transfer page. 

4. Click Templates tab. The system displays a list of templates. 

5. Click the Report button. The system displays the Template report dialog box. 

6. Select the appropriate check boxes for the templates that you want to include in the report, 
select PDF (.pdf) from the Format drop-down list and click Download report. When the 
system prompts you, select the local folder to which you want to save the formatted report.   

Note: By default, the system generates a PDF formatted report that uses the naming convention TemplateList_ 
MMDDYYYYHHMMSS.pdf. 

1. MM = the month that the system generates the PDF report. 

2. DD = the day that the system generates the PDF report. 

3. YYYY = the year that the system generates the PDF report. 

4. HH = the time of day in hours that the system generates the PDF report. 

5. MM = the time of day in minutes that the system generates the PDF report. 

6. SS = the time of day in seconds that the system generates the PDF report. 

 

7. Once you save the formatted report, open the report in Adobe Reader. The system displays 
the PDF formatted report for the ACH template. 

8. When you complete your review of the report, close Adobe Reader. 

9. Repeat steps 4 through 8 for each set of ACH templates that you want to generate a PDF  
formatted report for. 

10. Sign out of Business Online. 
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GENERATING CSV FORMATTED REPORTS – TRANSFERS 
Export functionality provides users with the ability to generate ACH transfer in a CSV formatted report 
when inquiring into individual transfers and transfer templates. 

Generate CSV formatted reports for ACH transfers 
1. Sign in to Business Online. The system displays Business Online. 

2. Select Payments & Transfers. The system displays the Payments & Transfers page. 

3. Select ACH. The system displays the ACH transfer page. 

4. Optional: Use the search criteria to narrow the list of transfers and click Search. The system 
refreshes the page with the new search results.  

5. Click Report to generate a report for all items that the system displays. The system displays 
the Activity report dialog box. 

6. Select the appropriate Type check boxes (for example, File information, Batch information, 
or Transactions) for the information that you want the system to include in the report.  

Note: If you select more than one Type check box, the system compiles the report in a Zip file, ACHReports.zip.  
This will include the selected Types (Transfer list, Batch list, and All Transactions) and the files will be named 
according to the name convention below. 

7. Select Comma separated values from the Format drop-down list. 

8. Click Download report. When the system prompts you, select the local folder to which you 
want to save the formatted report.  

Note: By default, the system generates the CSV formatted report that uses the naming convention 
TransferDetail_ MMDDYYYYHHMMSS.csv. 

7. MM = the month that the system generates the CSV report. 

8. DD = the day that the system generates the CSV report. 

9. YYYY = the year that the system generates the CSV report. 

10. HH = the time of day in hours that the system generates the CSV report. 

11. MM = the time of day in minutes that the system generates the CSV report. 

12. SS = the time of day in seconds that the system generates the CSV report. 

9. Once you save the CSV formatted report, open the report in a program like Microsoft Excel. 
The system displays the CSV formatted report for the ACH transfer. 

10. When you complete your review of the report, close the report. 

11. Repeat steps 3 through 10 for each set of ACH transfers that you want to generate a CSV 
formatted report for. 

12. Sign out of Business Online. 
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GENERATING CSV FORMATTED REPORTS – TEMPLATES 
Print  functionality provides users with the ability to print ACH transfer and ACH transfer template data 
in a CSV format when inquiring into individual transfers and transfer templates. 

Generate CSV formatted reports for ACH templates 
1. Sign in to Business Online. The system displays Business Online. 

2. Select Payments & Transfers. The system displays the Payments & Transfers page. 

3. Select ACH. The system displays the ACH transfer page. 

4. Click the Templates tab. The system displays a list of templates. 

5. Click the Report button.  The system displays the Template report dialog box. 

6. Select the appropriate check boxes for the templates that you want to include in the report, 
select Comma separated values (.csv) from the Format drop-down list and click Download 
report. When the system prompts you, select the local folder to which you want to save the 
formatted report.  

Note: By default, the system generates the CSV formatted report that uses the naming convention 
TransferDetail_ MMDDYYYYHHMMSS.csv. 

13. MM = the month that the system generates the CSV report. 

14. DD = the day that the system generates the CSV report. 

15. YYYY = the year that the system generates the CSV report. 

16. HH = the time of day in hours that the system generates the CSV report. 

17. MM = the time of day in minutes that the system generates the CSV report. 

18. SS = the time of day in seconds that the system generates the CSV report. 

7. Once you save the CSV formatted report, open the report in Microsoft Excel. The system 
displays the CSV formatted report for the ACH transfer. 

8. When you complete your review of the report, close Microsoft Excel. 

9. Repeat steps 4 through 8 for each set of ACH templates that you want to generate a CSV 
formatted report for. 

10. Sign out of Business Online.  
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IMPORT A NACHA FILE USING AN EXISTING TEMPLATE 
Import ACH Transfer functionality for NACHA files enables you to import a stored NACHA transfer file 
against a stored template. The system validates the transfer type and amount range (total transfer amount) 
stipulated in a selected template against the values in the imported ACH file. If the validation fails, the 
system displays an error message and the import process cannot continue. 

Note: ACH users who do not have access to stored templates can only import files without using a template. 

Import a NACHA file formatted transfer using an existing template 
1. Sign in to Business Online. The system displays Business Online. 

2. Select Payments & Transfers. The system displays the Payments & Transfers page. 

3. Select ACH. The system displays the ACH transfer page. 

4. Click the Import file hyperlink. The system displays the Import file page. 

5. Select NACHA as the Import type.  

6. In the File location field, select Browse. The system displays the Choose File to Upload 
window.  

7. Select the file to upload and click Open. The system displays the Import file page. 

8. Select the appropriate Template from the drop-down list.  

9. Click Continue. The system displays the File summary page. 

10. Click the Review ACH button. The system displays the transfer Activity edit page.  

11. Review the transfer details and make any desired changes, and then click Complete ACH. 
The system displays the confirmation page.  

12. Sign out of Business Online. 

 

IMPORT A NON-NACHA FILE USING AN EXISTING TEMPLATE 
Import ACH Transfer functionality for non-NACHA files enables users to import a stored transfer file 
against an existing template. The ACH transfer system validates the tax identification number, 
transfer type, and amount range (that is, total transfer amount) stipulated in a selected template 
against the values in the imported ACH file. If the validation fails, the system displays an error message 
and the import process cannot continue. 

Note: ACH users who do not have access to stored templates can only import files without using a template. 

Import a Non-NACHA file formatted transfer using an existing template 
1. Sign in to Business Online. The system displays Business Online. 

2. Select Payments & Transfers. The system displays the Payments & Transfers page. 

3. Select ACH. The system displays the ACH transfer page. 

4. Click the Import file hyperlink. The system displays the Import file page. 

5. Select Non-NACHA.  

6. In the File location field, select Browse. The system displays the Choose File to Upload 
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window.  

7. Select the file to import and click Open. The system displays the Import file page. 

8. Select the appropriate Template from the drop-down list.  

9. Click Continue. The system displays the New NACHA file import template page. 

10. Review the content. If the system prompts you, type the Effective date and click Continue. 
The system displays the Import file [File Name] page. 

11. Click Complete ACH. The system displays a status message about the imported file. 

12. Click Return to ACH activity.  

13. Sign out of Business Online. 

 
IMPORT A NACHA FILE WITHOUT USING A TEMPLATE 
Import ACH Transfer functionality for NACHA files enables users to import a stored NACHA transfer 
file without validating it against the fields stored in an existing NACHA template. 

Note: ACH users who do not have access to stored templates can only import files without using a template. This 
import process does not display the Template field for these users. 

Import a NACHA file without using a template 
1. Sign in to Business Online. The system displays Business Online. 

2. Select Payments & Transfers. The system displays the Payments & Transfers page. 

3. Select ACH. The system displays the ACH transfer page. 

4. Click the Import file hyperlink. The system displays the Import file page. 

5. Select NACHA.  

6. In the File location field, select Browse. The system displays the Choose File to Upload 
window.  

7. Select the file to import and click Open. The system displays the Import file page. 

8. Select Import without using a template from the Template drop-down list.  

9. Select the tax ID number from the Tax identification number drop-down list. 

10. Select the appropriate ACH transfer type from the Type drop-down list. 

11. Click Continue. The system displays the Import file – [File Name] page. 

12. Click the Review ACH button. The system displays the transfer Activity edit page.  

13. Review the transfer details and make any desired changes, and then click Complete ACH. 
The system displays the confirmation page.  

14. Sign out of Business Online. 
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IMPORT A NON-NACHA FILE USING A NEW TEMPLATE 
Import ACH Transfer functionality for non-NACHA files enables users to import a stored transfer using a 
new template. The system validates the transfer type and any other applicable information. If the 
validation fails, a message displays and the import process cannot continue.  

Note: ACH users who do not have access to stored templates can only import files without using a template.  

Import a Non-NACHA file using a new template 
1. Sign in to Business Online. The system displays Business Online. 

2. Select Payments & Transfers. The system displays the Payments & Transfers page. 

3. Select ACH. The system displays the ACH transfer page. 

4. Click the + Import file hyperlink. The system displays the Import file pages.  

5. In the Import file section, complete the following: 

a. Select Non-NACHA.  

b. Select the File location using the Browse button. 

c. Select Create a new template from the Template drop-down list.  

d. Select ACH transfer type from the Type drop-down list. 

6. Click Continue. The system displays the Import file page with all the import details. 

7. Complete the following: 

a. Type the Template name. 

b. Select the Tax identification number from the drop-down list. 

c. Select the Template group from the drop-down list.  

d. Select the appropriate Insert decimals into amounts option. 

e. Select Delimited or Fixed width as the file format.  

f. Type the number of Header and Footer rows to exclude. 

g. Select the Text qualifier from the drop-down list.  

h. Select all appropriate Column options. 

8. In the Apply additional values section select the appropriate Type from the drop-down list.  

9. In the Offset account options section, select whether you want the system to apply an offset.  

10. In the Effective date section, select whether the system uses the Date in file, Prompt for data, 
or  the Default current business date.  

11. In the User access section, select either All current and future users or Specific users. 

12. Click Continue. The system displays the Import file- [TemplateName] page which provides 
an overview of the data mapping.  

13. Type the Effective date and click Continue. The system displays the File summary page.  

14. Sign out of Business Online. 

  



 For Solvay Bank Customer Use Only · 2019 Solvay Bank · Member FDIC 
ACH Manager User Customer Guide (SB-622 • 7-22-19)  pg 15 of 20  

IMPORT ACH PASS-THRU FILES 
ACH Pass-Thru functionality extends your ability to indicate how the system handles individual 
batches populating an imported NACHA formatted transfer file, once it completes the import 
process. 

To import an ACH Pass-Thru file 
1. Sign in to Business Online. The system displays Business Online. 

2. Select Payments & Transfers. The system displays the Payments & Transfers page. 

3. Select ACH. The system displays the ACH transfer page. 

4. Click the Import file hyperlink. The system displays the Activity tab for importing files.  

5. Complete the following: 

a. Select NACHA.  

b. Select the File location field, select Browse. The system displays the Choose File to 
Upload window. 

c. Select the appropriate Template from the drop-down list.  

d. Select the appropriate Tax identification number from the drop-down list. 

e. Select Pass-thru from the Type drop-down list. 

6. Click Continue. The system displays the Import file [Import File Name] page. 

7. For each batch that populates in the ACH Pass-thru file, specify whether the system discards, 
saves, or processes the batch by selecting Discard, Save or Process for each batch.  

Note: If you select the Discard All option but do not want to discard all batches, ensure that you mark or save at 
least one of the batches in the ACH Pass-thru file for processing. 

8. Click Complete ACH. The system displays a message indicating the status of the file. 

9. Click Return to ACH Activity. The system displays the Activity tab page.  

10. Repeat steps 2 through 9 to import additional ACH Pass-Thru files. 

11. Sign out of Business Online.  
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REVIEW ACH TEMPLATES 
Approve new or modified ACH Transfer Templates before the template is available to use in a live 
environment with the Review ACH Template functionality 

Review ACH templates 
1. Sign in to Business Online. The system displays Business Online. 

2. Select Administration. The system displays the ACH Template administration page. 

3. Use the Search activity options (for example, Template type) to locate templates that need 
approval. 

4. Select the check-box for the appropriate template that needs approval and click Approve. The 
system displays the ACH Template administration page and adds the approved template to 
the list of Approved templates. 

5. Optional: Click the Print icon to print the list of templates that need approval. 

6. Sign out of Business Online. 
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VIEW INCOMING ACH TRANSFERS 
New Incoming ACH capabilities enable you to view incoming transfers and details of the transfers. 
Incoming ACH provides you with information regarding all incoming ACH transfers for individual 
accounts to help improve account maintenance and financial management.  

View incoming ACH transfers 
1. Sign in to Business Online. The system displays Business Online. 

2. Select Payments & Transfers. The system displays the Payments & Transfers page. 

3. Select ACH. The system displays the ACH transfer page. 

4. Select Incoming. The system displays the User List dialog box. 

5. Locate the appropriate user and click the name hyperlink (for example, George Washington) 
to view the list of accounts for the user that you selected. The system displays the Account 
Selection dialog box. 

6. Select the check box for the appropriate Account Number (for example, XXXXXX47). Click 
Submit. The system displays the Incoming ACH Trace dialog box. 

7. To view more information regarding the incoming ACH transfer, click the Trace Number 
hyperlink. The system displays the ACH Trace dialog box. 

8. Click the View File Details hyperlink to view detailed information regarding the incoming 
ACH transfer. The system displays the File Details dialog box. 

9. Review the information and click Done. 

10. Sign out of Business online. 

 

REVERSE ACH TRANSFERS 
Quickly reverse ACH transactions by inquiring into a batch or a specific transaction. This enables you to 
easily reverse a specific transaction, multiple transactions, or an entire batch. The system processes reversals and 
memo posts to all affected accounts.  

To reverse an ACH transfer 
1. Sign in to Business Online. The system displays Business Online. 

2. Select Payments & Transfers. The system displays the Payments & Transfers page. 

3. Select ACH. The system displays the ACH Activity page. 

4. Click Reverse for the associated transfer. The system displays the transfer page 

5. In the Pay To section of the Transfer Overview page, there is a Reverse None / Reverse All 
slider switch which allows you to reverse all items in the ACH file.  You can reverse select 
items using the Yes / No slider switch associated with each item.  Select Yes on individual 
records you would like reversed. 

6. Click Reverse ACH. The system displays the ACH List page. 

7. Sign out of Business Online. 
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ESTABLISH A NEW ACH TRANSFER TEMPLATE 
The ACH transfer system  provides easy-to-use templates for many transfer types, including payroll, tax 
payments, consumer debits and credits, cash concentration, disbursements, and vendor payments. ACH 
Transfer templates enable you to automatically define information about the receiving institution and to 
add multiple ACH transfers using easy to use templates. You can leverage all templates at any time, 
without having to reestablish each transfer one at a time. Any time that  you generate or process a new 
template, the system requires approvals in order for it to process transfers as accurately as possible.  

Note: To establish templates based on NACHA standard or non-NACHA (fixed width or delimited) file formats, use 
the ACH File Import Template function. 

Establish a new ACH transfer template 
1. Sign in to Business Online. The system displays Business Online. 

2. Select Payments & Transfers. The system displays the Payments & Transfers page. 

3. Select ACH. The system displays the ACH transfer page. 

4. Click the Templates tab. The system displays a list of available templates. 

5. Click + New payment template. The system displays the New payment template dialog box. 

6. Select Payroll – PPD from the Type drop-down list and click Continue. The system displays 
the New Template page.  

Note: We use the Payroll-PPD as an example only. 

7. Complete the following: 

a. Type a Template Name. 

b. Select the Tax identification number from the drop-down list.  

c. Select the Template group from the drop-down list. 

d. Select the Repeat check box if the template is for recurring transfers. 

e. Type the From amount. 

f. Type the To amount. 

g. Select the Frequency from the drop-down list. 

8. In the User Access section, complete the following: 

a. To enable the template for all users select All current and future users. 

b. To enable the template for specific users, select Specific users. Select the appropriate 
check boxes for each user that you want to have access to the template. 

9. In the Pay from section, complete the following: 

a. Optional: Type the Account number to filter by the account number of the 
Originating Depository Financial Institution (ODFI). 

b. Optional: Type the Amount to filter by the amount to be paid from the specified 
accounts to be debited. 

c. Optional: Type the Identification to filter by the identification number that the 
system associates with the originator of the transfer. 

d. Optional: Type the Name, to filter by the name of the customer that the system 
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associates with the account it debits from. 

e. Optional: Click the Pay all switch to turn on the Hold option for all transfers in the 
batch.  

f. Type the Identification. 

g. Type the Name. 

h. Optional: Type any Discretionary data. 

i. Optional: Type the Payment information to include notes about the transfer. 

10. In the Pay to section complete the following: 

a. Type the Name of the recipient.  

b. Type the Identification number of the recipient 

c. Type the Routing transit number of the recipient. 

d. Type the Account number of the recipient.  

e. Select the appropriate Account type from the drop-down list. 

f. Type the Amount to deposit in the recipient’s account.  

11. Select the appropriate Template Group from the drop-down list. 

12. Click Save. 

13. Sign out of Business Online. 
 

EDIT AN ACH TEMPLATE 
You can modify ACH templates using Edit template functionality.  

Edit an ACH transfer template 
1. Sign in to Business Online. The system displays Business Online. 

2. Select Payments & Transfers. The system displays the Payments & Transfers page. 

3. Select ACH. The system displays the ACH transfer page. 

4. Click the Templates tab. The system displays a list of available templates. 

5. Click Edit for the template that you want to edit. The system displays the Edit template dialog 
box. 

6. In the Description section, modify the Template name, Template group, From account, and 
To amount as needed. 

7. In the User access section , modify any user access specifications as needed. 

8. Modify the information in the fields populating the Pay from section and the Pay to section as 
needed. 

9. Click Save. 

10. Sign out of Business Online. 
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DELETE AN ACH TEMPLATE 
Delete Template functionality enables you to delete templates that you no longer have a need for. 

Delete a transfer template. 
1. Sign in to Business Online. The system displays Business Online. 

2. Select Payments & Transfers. The system displays the Payments & Transfers page. 

3. Select ACH. The system displays the ACH transfer page. 

4. Click the Templates tab. The system displays a list of available templates. 

5. Click Delete for the template that you want to delete. The system displays the delete 
Template page for the template that you have specified. 

6. Click Delete Template. The system displays the Templates page.  

7. Sign out of Business Online. 
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